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1. NEW FEATURES

1.1 Control Yaskawa GP series robots using PLCopen Motion Part 4 function blocks

With the addition of the Y_MSync library, PLCopen Motion Part 4 function blocks can control motion of Yaskawa GP series robot arms over EtherCAT when
the YRC1000 or YRC1000 micro controllers have the INPACT interface card installed. For details search the help file for Y_MS_INPACT_Driver.

1.2 ASM-X (SGDXS-0SAxxx) option card can be used for FSOE communication with SGDXS
servo drives

Safety functions and safety status can be accessed using FSoE communication with the SGDXS servo drives when the ASM-X (SGDXS-OSAxxx) servo option
card is installed.

1.3 ASM-5 (SGDV-0SAO01A) option card can be used with Sigma-5 servo drives

The ASM-5 (SGDV-OSAO01A) can be used with Sigma-5 servo drives to implement safety functions.

1.4 HMI Designer is integrated with iCube Engineer

iCube Engineer and HMI Designer can share variable name and datatype information. It is recommended to start HMI designer separately from iCube Engineer
instead of launching HMI Designer from inside iCube Engineer.

There are some limitation with this integration that will be resolved in the next release.

1.5 EtherCAT PDO map editing is supported

The PDO map for EtherCAT devices can be edited in iCube Engineer.

1.6 Controller Commissioning Tool is available

A stand-alone Windows application, Controller Commissioning Tool, is available for installing and managing feature licenses on the iC9200 controller.

1.7 Rotary knife supported in the Cam toolbox

Rotary knife applications are now supported by the Cam toolbox.

1.8 iCube Engineer 2024.9 is based on PLCnext Engineer 2024.6

There are improvements in iCube Engineer 2024.9 that come with the incorporation of PLCnext Engineer 2024.6. These improvements include:

. Data lists and port lists now provide import and export functions for csv-files. With the import into a data list of a device, new process data assignments can be
added.

. Defined constants can now also be used to set the length of a user-defined string.

. Arrays and user-defined strings can now be defined directly in a variable worksheet of a local POU and in the list of global variables. A definition in a separate
datatype worksheet is not necessary anymore

. The documentation of local function blocks can now be opened in the browser via the help command of the context menu in FBD/LD or the shortkey
“shift“+“F1“ in ST.

. The format of online values can be set for every single variable separately. The setting is synchronized between code and variables worksheet as well as the
WATCHES window and the FORCELIST. All changes can be reset to the default format via the “Options“ menu.

. In all programming editors the subeditor “Variable Properties* can be opened via the context menu or toolbar. All properties of a selected variable can be defined
here without switching to the variables worksheet.

. The user can switch to debug mode even if the name of the currently opened project in PLCnext Engineer differs from the name of the project running on the
connected controller

Release Notes for iCube Control Products July 24, 2025, Page 2 of 44



2. FIXES INCLUDED IN THIS RELEASE

2.1 Fixed in iCube Engineer 2024.9.1 (Build 6.0.31960)

files overwrites the control
word of the servo

ID Title Description
. Add a combination of EtherCAT slaves that result in a non-sequential order of
Invalid offset of servo 10 . . .
variables in the configuration the slaves process data in the EtherCAT process image and the resulting servo
69607 & 10 variables will have incorrect offsets. This problem most often occurs with a

combination of SIGMA-7 and SIGMA-X servo drives. Due to the incorrect
offsets, the motion or 10 may not be function as expected.

2.2 Fixed in iCube Engineer Release 2024.9.0 (Build 6.0.15981)

ID Title Description
Autocompile feature does not
work reliably using PCWEX Autocompile frequency is not reliable sometimes. This causes the last
36237 format so that sometimes the compiled code (not the code currently available in the project ) to be
last compiled code is allowed to | downloaded to the controller. This would result in a mismatch of code in the
be downloaded (written) to the | project and the code running on the controller.
controller.
Safety project templates can
only be opened in the language . \ .
42355 setting, with which they were Safety project template can't be opened in German language.
created.
|Cubg not responding and If iCube Engineer's EtherCAT online functions page is online with the
showing random EtherCAT data . .
- controller, and a change in state (power loss) of any device on the etherCAT
43653 | when Node is disconnected . . . . . .
. . . network or if there is change in the network (disconnected device), the online
with the Online functions tab . .
functions page can become unresponsive.
open and hot connect enabled
The following module listed in the catalog of iCube Engineer is not
supported.
47538 | Unsupported Modules in iCE
1. Al 8x12Bit (0/4)..20mA (031-1BF60) Rev. >= 00/1.00 on
PROFINET
48936 Y_YA_EC_Diagnostics can get When only one EtherCAT device is connected, Y_YA EC_Diagnostics is unable
stuck to complete its read operation, and gets stuck Busy in an internal step.
ESI file import: Error Importing . . . L
48980 Schmersal Safety Field Box ESI Import of Schmersal Safety Field Box ESI fails. This device is not supported.
ESI file import: Error Importing . . . L
49054 Fortress amGardPro ES| Importing of Fortress amGardPro ESI fails. This device is not supported.
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In some scenario in LD, the execution order of the code is wrong as follow :

1 Test3 2
KX Test
}/ar1
Incorrect execution order in 11 Execute Done
49197 .
Ladder Logic ID Busy
var2 I I
| | Limit Error
ErrorlD
iCube Engineer crashes if the Write and Start commands are edited from the
Extras > Options menu in iCube Engineer's home page. (without opening a
project)
Modify application options
Select category and edit options
4 International ~ Write and Start Commands
International Settings Write and Start
Default Language Settings . )
Write and Start with Sources
4 Tool
Auto Save Write and Start Changes
Diagnostics Write and Start Changes with Sources
Auto Increment Write and Start incl. Safety
Software crashes when —_—
selecting 'Write and Start incl rectornies Write and Start incl. Safety with Sources
49305 . ) Recycle Bin
Safety' from the Write and Start : Dot .
. ipti efault command:
Commands config Blescripion .
4 Text Editor
General
Tabs
4 Printing

Company Information
Settings

4 Online
Online Values
Communication Settings

Write and Start Settings

Write and Start Command

4 Compiler
IEC Compiler Settings
Warnings Settings

w
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iCube Engineer 2024.3 removes
the POU of a project build in

When converting a older version project into iCube Engineer 2024.3, with the
following pop up :

This project was created by 'iCube Engineer 20;

A conversion is necessary.

If project is under integrated version control, a git-pull/svn-update is performed
to ensure the integrity of the project structure.

A backup of the project will be saved as 'C\Users\Public\Documents
\YRMiecEngineer\DevLibraries\Toolboxes\Source Code\backup

Do you want to create a backup for the project?

Yes No

I Cancel I

the following error can appear:

devices, EoE-EtherCAT devices
and EthernetlIP devices

49501 . . . .
earlier versions during project
convers | on Q The path to the file exceeds the maximum length or the file does not exists in ‘adeproject.//
Resulting in corrupted code display as follow in the component tree :
M,
One of the possible reason other than the maximum length is that the POU,
FB or datatype worksheet have been renamed in the previous iCube
Engineer version with the same string name but different font case, example :
"pou_1" replaced with "Pou_1".
During the conversion the link between the component tree and the file is
then lost afterward.
Error: "A license error has After a few hours of running iCE and possibly staying idle, a pop up message
51211 | occured" after locking computer | saying ' A license error has occurred' appears. The only option is to click OK.
or energy saving mode The user can lose unsaved code.
IP address conflicts, when
creating an iCE project with PN . .
52962 & proj IP address conflicts can occur between devices on the controller subnet.
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53293

Safety PLC Write & Start Project
Stops Working

Users may experience cases where the project Write & Start function does
not work. This can occur with both the Standard PLC -> Write and Start (incl.
Safety) and also the Safety PLC -> Write and Start functions. When this issue
occurs there are several indications that the user will not see, which should
appear within approx. 10-20 seconds of stating a Write and Start. These
missing indications include Progress bar and status messages such as shown
below:

W Zoeiiepreq view roddeq 10 [1] I | > MIU1U3 (01 2916 brC 10 20916

- 2916FA-16|956q Yi6s: roadeq |U - m M311UQ {OL COULO||6L O |09 CoUpANLIfIoy

W 356ih-16[9¢6q yLeu: roadeq |u Mue brolect £0 2946\ bIC \1

|

- z!Qs;-LG[s(Gq wi69: rosq w [I] Bnqiuad brolecy

Also, iCube Engineer will not display snack-bar messages such as:

Build succeeded

0 errors
55 warnings (MSG_GENO0O

Writing the program to the Safety PLC succeeded!

Restart initiated! (SONL1000)

Another effect of this issue is that iCube Engineer will hang when closed. This
can be seen in the Windows Task manager by looking at the Task Manager's
Details screen, for example:

1,652,584 K x64 iCube_Engineer.exe

Ryan_Butler 00

i’ iCube_Engineer.exe 30412 Running

55296

FB-Lib:
Y_FileRW_Toolbox_2024_03:
Y_RW_Write_CSV_File:
Appending more than 512 Byte
to the CSV file leads to an error

Using Y_RW_Write_CSV_File with a Buffer size above 512 bytes generate a
string error on the PLC side.

56844

Y_GroupDirectControl not
correctly handling PCS coord
system input

Y_GroupDirectControl does not correctly handle the CoordSys input to select
between ACS/MCS/PCS coordinate system. The coordinate system may be
misapplied to some other coordinate system instead. This can lead to
unexpected motion behavior.

For example, inputting MC_CoordinateSystem#PCS may instead execute the
move data in MCS instead.

57006

Parameter tab missing for
Sigma-X drives using catalog
entry ending in 0x10002

The parameter tab is missing from device configuration page of Sigma-X
drives if revision number 0x10002 of the SigmaX servo is chosen while
performing an etherCAT bus scan.
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Velocity input on
57927 MC_TorqueControl does not The velocity input on MC_TorqueControl does not limit the velocity in torque
limit velocity on Direct Drive mode for direct drive motors.
Motors
During EtherCAT bus scan, if the discovered device profile does not match the
Bus scan misidentifies SGDXS device profile of S.Iml|al‘ dgwces from th'e sam.e vendor, the user is asked to
. ) chose an appropriate device profile available in the catalog. The user can
unit as SGDXW when using . .
58067 |, . choose to use the same catalog profile for other devices that may be
Apply the selected file to other | . - . "
L " discovered and have the same decision to be made by pressing the "Apply the
similar slaves . . . . .
selected file to other similar devices' check box. This check box selection may
lead to erroneous results.
EIP assembly instance . .
. . When the iC922x controller is an EtherNet/IP adapter, and the user changes
configuration: Error on . . .
58268 . the assembly instance number of an instance that already exists, the ports
download after EIP instances mappings get corrupt and the project cannot be downloaded
are changed (swapped) PPiNgs & P pro) )
Y _CO_FTP_SendFile Function
58359 Block reports timeout error Y _CO_FTP_SendFile Function Block reports timeout error incorrectly even
incorrectly even though the file | though the file gets sent.
gets sent
Regression: iC9226 does not
work as an OPC UA server to The "DNS name/ IP address" does not stick when changed. This is an issue
62013 | HMI designer because DNS because in order to enable communication this needs to be set to the server's
Name / IP Address Not IP address.
Accepting Entered Value
. When working with the German version of the software, MC_Power will
In German Version of ICE L . o
62208 MC Power oes into error 4625 always go to error even before enabling it when using any axis with
- & DriverType = FMK. ErrorID given is 4625.
ASMD5: Invalid constant error
63101 and AT error when an ASM5 When an ASM5 module is added to a servo in iCube Engineer, a compile error
module is added in iCube is generated because of a an autogenerated variable in the PLC data list.
Engineer
R ion: EtherNet/IP (EIP):
egression erNet/IP (EIP) iCube Engineer does not allow the iC9200 as a scanner to open more than
63129 | Unable to create two adapter . .
. . one adapter connection to the same device.
connections to the same device
Regression: Help for FBs does Right clicking a function block instantiated in a POU or looking for help from
63178 .
not come up in 2024.9 SP5 the component tree does not work.
Software cr'ash: Ran<?|om ?rash iCubeEngineer crashes because of interaction with OneDrive. OneDrive blocks
63223 [ without doing anything (likely e . . .
. access to certain files iCube Engineer is looking for.
due to Autosave + OneDrive)
Regression: SigmaXT - Selecting the parameter page for any module on a SigmaXT or SigmaXW servo
63373 | Parameter Screen Hangs and while connected to the controller and in debug mode can lead to iCube
Crashes iCube Engineer Engineer being unresponsive.

2.3 Fixed in iC9226 Runtime and Motion with this Release

ID

Title

Description
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MC_TrackConveyorBelt reports

The GroupReadStatus::InPosition output does not come on when
MC_TrackConveyorBelt is complete on a group with real axes that
has disengaged. This is a regression from the MPlec product. It

other motion

31986 | MC_GroupReadStatus::InPosition output appears to be a reporting problem, but the motion should behave
incorrectly for groups with real axes properly. There are no known workarounds specifically for the
InPosition output. Application code should not rely on the
InPosition output to tell the group state.
MC_SetPosition reports error 4380 after .
46129 | MC_TrackConveyorBelt is used with no MC_GroupSetPosition reports error 4380 when executed after

MC_TrackConveyorBelt.Done and motion is idle.

49331

MC_TouchProbe can not take ownership of
TouchProbe after failed attempt to take
ownership and then completion

In a multimodule set up (servo is module 1 and feedback option
card is module 2 ), the two modules cannot swap ownership of
the touchprobe.

Example:
o modulel arms latch for touchprobel
o modulel latch aborted

o module2 arms latch for touchprobel. Not allowed.

49665

Incorrect PCS calculation when using an
auxiliary axis in a Group

The presence of an auxiliary axis in a group can lead to incorrect
calculations of the PCS offset when using Y_GroupSetFrameOffset
and/or MC_TrackConveyorBelt.

MC_MoveCircularRelative incorrectly

MC_MoveCircularRelative does not correctly apply the relative-
offset when checking for a potential positions outside the

is an active servo alarm

50022 | reports error 9002 (unreachable position) | workspace, i.e. due to nonlinear kinematics such as Delta robot
in some cases kinematics. This can lead to spurious 9002 errors if the un-offset

position lies outside the workspace.
For PLCopen Part 4 multi-axis groups, MC_Move type function
blocks can become busy indefinitely in certain scenarios for
groups which contain both translational and rotational axes - for
example, an XYZRz gantry.

52948 MC_Movelinear does not complete when Thi . _

"incorrect” velocity unit specified is occurs when either the translational component or the
rotational component of the move (but not both) has zero
magnitude, and the input value of
Yt_GroupMoveOptions.VelocityUnit matches the zero magnitude
component.

Pn20E and Pn210 (electronic gear ratio numerator/denominator)
should be set to 1:1 for proper operation with the motion kernel.

Pn20E,Pn210 non 1:1 can cause fatal iCube Engineer enforces this requirement.

56721 | hardware exception or incorrect initial When these values are set away from 1:1, then incorrect initial
startup multi-turn position start position can be read at program warm start time.
In extreme cases, an integer overflow can occur which causes a
controller crash.
Y _F1_ WriteParameters reports error 4915 | When a servopack is in an alarm state, Y_WriteParameters
56925 | (eeprom save not supported) when there | incorrectly reports error 4915 after .Busy output for 30 seconds,

without initiating the final save-to-eeprom operation.
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PLC reboots continuously after 30 seconds

After deactivating SliceBus Service in Web Interface Services the
PLC reboots continuously after approximately 30 seconds.

gateway address crashes plcnext and
reboots controller

58344 . . . .

when disabling SliceBus Service in WBM There is no connection possible to the iC9200 due to the reboot

cycle.

Unable to use counter module on iC9200 Unable to use counter module on iC9200 Slicebus if there is
58463 | . e oar .

slicebus if it's the last item on the bus another counter module on the bus.

. . In certain rare situations, the AXIS_REF internal state machine can

Axis can become stuck in ErrorStop after . -
61678 become stuck in ErrorStop state and not correctly transition to

successful MC_Reset .

- StandsStill or ErrorStop after a successful call to MC_Reset.

EtherNet/IP Scanner - Unreachable remote | If the controller's network configuration includes a Default

62227 device IP Address with off-network Gateway which is not on the local subnet, then Ethernet/IP

Scanner connection attempts to remote adapters also not on the
local subnet will cause a fatal controller crash and reboot.

62408

Servopack alarm clear causing motion scan
overrun, watchdogs, or controller reboots

Clearing CoE servopack alarms via MC_Rest, WBM motion alarms
page view, or iCube Engineer motion alarms view can in some
cases result in motion scan overrun alarms, PLC task watchdogs,
or controller reboots due to system watchdogs. These effects
seem more likely on heavily cpu-loaded systems, especially on
FSoE controllers.
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3. OPEN ISSUES

3.1 iCube Control Safety Process Related Issues

ID Title Description Workaround
When a safety component has a PDI
Safety PLC is stuck in (Process Data Item) linked to a normal PLC | Every safety device should have at least
STOP if no safety variable but not to a safety variable, there | one safety PDI (Process Data Item)
46087 . . . - . . .
variable are linked to is no compilation error, but the Safety PLC | linked to one safety variable (input
the safety device pdo. remains in Stop state even on trying to run | and/or output).
the safety PLC.
Zzzt:/nzl};cp.i:goocf?‘::t ic When a FSoE slave is deleted, the offset of
49198 the remaining slaves is not recalculated, so | Not available.
not updated, when a there are empty spaces in the mapping list
safety slave is deleted. '
Message "The safety message log has no
valid data hash" on project opeing will
occur if the iC9226M-FSoE project is
opened in a different time zone than the
Message "The safety . . .
one it was saved in. The message is
\rg(izszi(:;%ga;?f 2: related to a ha.Sh used in the persistent Once the project is saved again in the
49597 . safety log. This defect does not new time zone the error will no longer
opening caused by represent a safety-critical defect, as the | occur on opening the project.
safety project created | gafety Jog only has a logging function
in a different time zone | 3ng has no influence on safety-related
data that is used to generate the
safety-related user program.
WBM Archive Project Project archive feature in the WBM cannot . . -
Use iCubeEngineer to commission
52878 | does not handle safety | be used to manage (send to controller or .
. . i (download) safety applications.
project receive from controller) safety projects.
When using an AXL SE FSDO4/2 safety
Phoenix Contact safety | digital output module in an AXL F BK EC
62599 | DO (AXL SE FSD0O4/2) EtherCAT coupler from Phoenix Contact on Ei?gi:;touustepmemi)ijl_u?s FSDO4/2 safety
not working the EtherCAT node, the safety controller )
will not be able to go into Safe Run.
After download changes of the safety
Download Changes for | project, the new safety project is not Contact customer support for details of
67937 | safety is not always executed. This only occurs if the the problem condition and the
effective. Download changes is rejected due to a workaround.
configuration or other similar change.

3.2 iCube Engineer Known Issues

ID

Title

Description

Workaround
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'Create New Function A function block instance cannot be .
. . . L. . Drag and drop an instance of a
Block Instance' option created by right clicking and choosing to .
9546 . . ; function block from the components
doesn't exist when editing | create a new instance from the code tree of the proiect
in ST environment editor of a Structured Text worksheet. project.
Errors such as division by zero may not be
Error (division by zero) is | traceable to the exact line where the error | The error could be displayed on a line
21016 | displayed in the wrong occurred. The error line could be wrongly | near the line where the error
line of code shown on a line in the vicinity of the error | occurred.
occurrence.
The import from CSV file functionality to
import variable in the data list of the PLC
P e . . " The PDI mapping to the imported
Import csv file in the table mention "Finished importing CSV", variable needs to be done manually
variable table does not but doesn't import any PDI linked to the )
25444 retain mapped PDI imported variable. The imported variable that are
variables duplicated needs also to be removed
D manually.
Finished importing CSV file. (MSG_GEN0060)
The CreepDistancelLimit is not enforced
26625 | CreepDistanceLimit not €8 . . Not available.
. MC_StepRefPulse function block is
enforced on Re-Trigger . . . L . .
ignoring the distance limit during this
case.
Multiple scans may be required to
detect Profinet devices on the
network.
Or download
Controll d . . ;
58153 P:);fi:\(:etirc:(;\ag:nr:t detect Controller scan and Profinet Scan does not | NetNames+ : https://www.phoenixco
. . detect profinet devices always ntact.com/en-pc/products/data-
devices all times interface-em-pnet-gateway-ifs-
2904472
. gy . Opening a project that contains a Yaskawa
P t Rebuild d
roject Rebulld Is required |, i et(SI-EP3) VFD (GA500 or GA700) , ,
on project open if . . . Execute a Project-->Rebuild, then
30202 ) . which was working before ends up in . .
Profinet VFD devices are . o . download the project again.
in the configuration Y_MotionAxisDriver with an
& Error&erroriD 13807 .
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Global Replace function creates a new
variable and keeps the current one that
was supposed to be replaced
Global Replace - creates a Manually remove the old variable if it
new variable and keeps is not required. User could evaluate if
31416 . . .
the current one that was Refactor' could be used instead of a
supposed to be replaced 'Global Replace'
Names of variables from the Safety PLC
project will appear in a list of available
variables when working in the standard When selecting a variable name, first
PLC project. This occurs when typing a open the variable list drop-down and
variable name - see the example below - | then select "PLC" to filter only for
as well as when browsing the variable standard PLC variables.
' names in the drop-down list. If a safety
Safe variable aren't _ PLC variable is used within the standard
32554 | protected from the main | p| ¢ project this will cause an error when o .
PLC the projectis rebuilt. | PEEETE weees 7T o
EEEEE NIy §
ot g e
Aft ki h to the PLANT
Flag all changes to Motion | Changes made to the PLANT Configuration ef ma |‘ng ¢ anges‘ © e.
. configuration, the project will have to
41425 | area of plant to prohibit cannot be downloaded to the controller .
. . . be recompiled and a full download
download-changes using the 'Download Changes' command.
has to be performed.
Visually review LED states present on
the SLIO safety modules and refer to
the meaning of the LED indicators in
) ) the technical manual .
SliceBus safety module D|agnF>st|cs for the SLIO'safety modules on | (https://www.yaskawa.eu.com/Global
42328 diagnostics not available tche SliceBus are not available through %20Assets/Downloads/Technical_Doc
iCube. umentation/Controls/Slio/Safety/HB3
00E_SM-S_02x-1SD10_23-20.pdf)
See the section "status indication" as
a starting point.
A.A48 on Sigma-7 when The A.A48 al'arm indicates corruption ‘of . . o
L . the Servo drive EEPROM memory, which Use SigmaWin+ to initialize
43101 | using iCube Engineer . . .
. includes the servo drive parameter parameters on the servo drive.
servo parameter editor settings

Release Notes for iCube Control Products

July 24, 2025, Page 12 of 44




In the Safety PLC cockpit messages, the
In safety PLC messages . .
further information to the | €0 pomt. to internal errors that are
. hard to decipher.
error codes in Columns Contact Yaskawa for help on safety
43610 | "Additional information"

PLC errors.

and "Extended

information" are not

available
there are 2 solutions:

e add the Profinet VFD from the
catalog manually instead of
automatically with the
Profinet scan

Drive scanned from the e add manually Profinet

Profinet network doesn't | Executing a Profinet scan functionality on telegram to the Profinet VFD
43636 | automatically add the Yaskawa Profinet VFD doesn't add the after the scan has been

GAx00 Motion Config Profinet telegram Part. executed:

module

e Do not use any FB from Safety
IEC 61131-3 in a nonsafe PLC.

e Use implicit addressing as
shown below:

If a WORD_TO_BYTES FB is used in the _
non safety FB from application, a compile error is generated
46312 "Safety IEC 61131-3" mentioning that the iC922x resource does
library aren't supported not support the WORD_TO_BYTES
on iC922xM-EC function block because this FB is part of
the Safety IEC 61131-3 library.
[owee (o]
1 bytel := wordy.BO;
2 lbytez = wordy.Bl;
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. . . If a user modifies the axis number
Motion Axis generation . . .
. property of a motion axis and then adds Do not change axis number property
fail to create the proper - . . . . .
. additional motion axes to the project, of a motion Axis if additional
46399 | variable when . .
. . . then the automatic generation of the servopack need to be added to the
Identity.Axis Number is } . .
AXIS_REF variable in the PLC/global project at a later stage.
changed from default . .
variable table is affected.
If the 'Data’ Process Data Item of a safety
module is connected to a PLC variable as
shown below, the project cannot be
GDS'E”?“ when downloaded. The Data PDI should not be
connecting the data edited by the user. Do not edit the Data PDIs for safety
variable of an FSOE- modules.
46400 | module with a non-safety
plc variable - this variable Contact your Yaskawa support and
connection is not undo- buti provide the reference #46400
a b I e > Variable (Safety PLC)
'Servonet external axis' is The automatically created external
not automatically created axis (when an SGDV Feedback Option
when a 'Feedback Option | If an SGDV Feedback Option Card is added | card is added to a servo) is only used
46740 | card' is added to aservo | to a servo in the plant, an external motion | in Option mode = "Semi-closed loop +
and feedback operation axis is automatically created. External encoder monitoring". In all
mode is 'external encoder the other operation modes, this
monitoring'. external axis created is not useful.
Make space in the ladder diagram
Modify ladder diagram rung with common l:é(;fore inserting the OR connection
power rail can bring organization display contact.
issue as follows.
LD Network Graphics oA
47608 i\ oo 5 OR
Incorrect :,3\\
s T .
— \::5— Do not make the power rails
continuous for multiple rungs.
mcron e LD sod doss v
organize itself properly oy e ‘ con 2
con oot 1] ;
=) I_—iaa; coos.
021-1BD70 & 022-1BD70 TimeStamp
User can't use 021-1BD70 | modules can NOT be synchronized with an | No workaround available. A virtual
48061 | & 022-1BD70 TimeStamp absolute time. module to simulate the clock is
modules with the internal | These 2 modules can only be used to read | Missing for Profinet, EtherCAT and
clock of the iCube or defined a time relative to a previous Slicebus.
rising/falling edge.
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MSG_ONLO156: Unable to
download project and
unable to find the reason
for the download failure

49219

If the error message "MSG_ONL0156:
Unable to download the project changes
to the device" is shown, the user will have
to check the reason for the download
failure in the output log of the controller.

The output log can be obtained by
SSH-ing into the controller. The output
log can be obtained at
Jopt/plcnext/logs.

Automatic IO Variable
generation : PDIs links to
PLC variables are not
displayed in the data list

49241

The automatically generated variable may
not have a Process Data Item linked to

it. The link is made automatically by
iCube Engineer automatically in the
background. If the user map a PDI, this
will overwrite this automatic link done by
iCube Engineer.

The user should NOT try to map a PDI
to the variable. The link is already
done in the background and the
communication with the device
should work properly.

PDO : Pressing "load PDO
information" results in
warning messages about
process data item
creation

49637

If user selects to 'load PDO information'
from the ECAT sub device's PDO data tab,
process data creation could fail because of
a datatype mismatch.

Do not use the 'Load PDO information'
button on the PDO tab of an EtherCAT
sub device.

OPC UA PubSub
Subscriber can receive
data from an incorrectly
configured publisher

49821

An incorrect configuration can lead to
data inconsistencies that are easy to
troubleshoot. For example, if there are
two publishers, one publisher configured
correctly and the second publisher
configured incorrectly (with the same IDs
as the first publisher), the subscriber will
get data from both publishers. There is no
mechanism to filter data from an
inadvertent wrong configuration

The user should take care to configure
and set up publishers correctly.

Cannot Debug/Monitor
Safety PLC Variables after
Write and Start Standard
PLC Project

49949

After writing and starting a standard PLC
project, done while debug and monitoring
of both the Standard and Safety PLC
projects are active, the values reported for
Safety PLC variables will not match the
actual values and a reintegration request
is required.

Following the Write and Start of the
Standard PLC project, it is necessary to
set ACK_REI_FSOE_GLOBAL=True to
provide a reintegration request. Once
the reintegration request is provided,
the variable values shown when
debugging match the actual states.
Set ACK_REI_FSOE_GLOBAL=FALSE to
complete the process.

Unexpected Error -
Project Cannot Be Built.
Online Mode Is Not
Possible

49950

When rebuilding a project after making
edits in the standard PLC area and while
still connected to the iCube controller, iCE
may report "MSG_ONL0048: The project
cannot be built. Online mode is not
possible."

Disconnected from both the standard
and safety PLC, then rebuild the
project (Project->Rebuild)
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Safety PLC does not exit

>0132 Debug Mode

Under some circumstances the Safety PLC
does not successfully exit debug mode.

Ensure the safety PLC enters Safe Run
mode after exiting debug mode by
checking the safety PLC status. The
safety PLC status can be seen in the
iCube Engineer Safety Cockpit. The SF
RUN and SF ER LEDs on the iCube
controller also display the safety PLC
status. Safe Run is indicated with the
SF RUN LED solid and the SF ER LED
off.

If a valid project is not loaded onto
the Safety PLC it will be in Debug Stop
state, and in this case it is not possible
to exit Debug mode. Check the Safety
Cockpit -> Safety PLC project
information to see if a project is
currently loaded.
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50179

Unable to use the same
toolbox library with a
different path than
default library path: "The
reference library could
not be loaded because
the library ...... "

If the user moves the library folder with
libraries in it to a different location,
projects which refer to the libraries in the
original project will have compile errors
when the old libraries are deleted and the
libraries from the new location are added.
The compile error is "The reference library
could not be loaded because the library
xxx with the same ID has already been
loaded"

There are options:

e Do not change the library
location for an existing

project.

e Sharea

project as an archive.

e Fix the library location as

follows:

1.

In Window Explorer:
Copy all the libraries
used in the project in
a new folder location

in iCube Engineer:
open: "Extras" -->
"Options..." -->
Tool/Directories

modify the path of
"User libraries
location" to the new
path defined in step 1

save the project

close completely
iCube engineer (not
only the project)

re-open iCube
Engineer and the
project

a. Allthe paths
for each
library should
be modified
and no error
should occur.

50997

Execution of 'MC_Stop'
returns Error with ID
'14054' on
'Y_MotionAxisDriver' FB
for ModbusRTU Drives

Sometimes the first execution of the
'MC_Stop' for a Drive controlled with
ModbusRTU (040-1CA00) Function Block
is not working properly. The axis will not
stop in this case, the Driver Function Block
will return an Error 14054,

Always check the Y_MotionAxisDriver
FB status when using ModbusRTU
Drive with PLCopen_Part1 library.

51198

Missing documentation
for PLCnextBase in ICE

version 1.5.1 does not contain any
documentation

Use documentation of the Version
1.6.4 version is available via

PLCnextStore
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"Import SigmaWin+ .usrs file" always
Sigma-XT: "Import imports the parameters for the first axis
Si Win+ . file" i
alli,rzas irl: O;[Zr:h;e regardless of axis selected. Do not use the Import
52815 Y P ) SigmaWin+.usrs file functionality in
parameters for the first 3 B C iCube Engineer for multi-axis servos
axis regardless of axis g )
selected ! # : . :
ameter Import SigmaWin+ .usrs file
ECAT: G ted P
Data na:l:sr?coi lorr\oc;srs The Fortress amGardPro device can not be
52956 g used due to the generated Process Data Not available.
Fortress amGardPro and .
. names being too long.
other devices
In the Statusword of SI-EP3 PROFINET
option card there is no information about . .
i u the Multiprotocol Card JOHB-
SI-EP3 PROFINET Option | 570 (safe Torque Off) inside the Status °Ing tne WU tIprotoco’ ~ard
Card for VFD: No SMP3 (PROFINET mode) there is the
Word. . L .
53109 | information about STO STO information in Status Word Bit 14.
inside Status Word Therefore there is .no reaction possible Control/Status has to be set on 1:
available with the MC Function blocks (e.g. .
. . Yaskawa P-Drive
MC_MoveVelocity, MC_ReadStatus) in
case of STO
There are 3 possible workarounds in
this situations:
The User libraries are installed at the time L s ‘Cube al in Run A
of software installation at the following ' tart,' 'u €a w‘ays |'n un s
path: Administrator, in this case the
C:\Users\<user>\Documents\iCube_Engin the d('efauljc pa'th'to Iookfor
. . user libraries in iCube will
eer\Libraries.
change
If the installation is done as administrator, to C:\Users\<user>\Document
Installing iCube Engineer the <user> is the administrator account. s\iCube_Engineer\Libraries.
as administrator and In case the administrator and the local 2. Incase you don't want to Run
53202 | opening as normal user user are two different accounts, and iCube the iCube in Run as
create issue to find user Engineer is being opened from the normal Administrator then after
libraries location user, the following error will occur: running iCube change the
"Library not found at referenced location". path in the iCube software
where it looks for the user
libraries. For this go to Extras-
>Options->Tools->Directories-
>User Libraries location.
3. Copy the library from the
administrator folder to the
user folder.
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53415

Wrong online values in
execution mode are
displayed

The value of an expression will not be
shown if the expression contains variables
in it. For example, On line 2, the value of
the right side of the equation

is not shown. On lines 4 and 5, the value
of the right side of the equations of the
two lines are evaluated and displayed
correctly.

Not available.

53540

Unexpected controller
reboot when using
PBCL_SysDeviceStatus_1

Depending on the data type used in the
InOut variable "anyResult", the controller
might unexpectedly trigger a power cycle
(reboot).

When using PBCL_SysDeviceStatus_1,
set the data type of the variable
connected to "anyResult" to the one
defined in the documentation for the
status variable specified in
"strindent". For example, to read
"Status.Memory.Usage.Percent"
(defined as a BYTE in the
documentation), define the variable
connected to "anyResult" as a BYTE
data type.

53699

Generated Safety
Variables are not removed
when Safety modules are
deleted

Generated Safety Variables are not
removed when Safety modules are
deleted

Delete the safety variables after
removing the safety modules

54301

Deleting a servopack from
the plant leaves behind
servo 10 global variables

When a servo is deleted from the
EtherCAT node in the PLANT tree, the
global variable that represents servo 10 in
the PLC data list is not deleted.

User can manually delete the global
variable from the PLC data list.

54418

Cannot rebuild project,
Internal error: UTLO001

Internal error UTL 0001 can occur if one of
the temporary output files is locked.

Make sure no files in the Binaries
directory are locked from editing due
to be open in an editor.

54483

ECAT Online : missmatch
analyzer is showing
Sigma7W servopack
modules in red

In the EtherCAT online functions page,
modules that are part of multi module
devices, are sometimes shown in red.

Check the state of the EtherCAT device
and ensure that the device is in state 8
(OP state).
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54492

iCE Active window crashes

when attempting to
cancel the load of a
variable into the watches
tab

While loading a new variable (which is a
large structure) into the watches tab,
canceling the operation by clicking the X
in the "Creating watch items" window
currently crashes the active iCube
Engineer window.

Creating watch items

PartType
Processed 78%
—— N

54882

Impossible to bring back
undocked window from a
disconnected monitor

If an iCube Engineer window was
undocked and moved to a secondary
monitor, and if the user disconnects the
secondary monitor, it is not possible for
the user to bring back the undocked
window back to the original monitor. The
click action to make the window visible
seems to work, but the window does not
appear on the original screen.

Wait for variable to load into watches
tab completely, and then remove it.

Below 2 possible solutions:

1. Rightclick on Windows
desktop > Display settings >
Select 1 monitor.

OR

1. IniCubeEngineer press
CTRL+Tab and select the
missing window with the
arrow keys (i.e. Logicanalyzer)

2. Press Windows+Shift+Arrow
to move the selected window
from monitor to monitor.

55375

Multiple bus scan
proliferates Motion Axes
instances

Performing an EtherCAT bus scan does not
automatically delete existing Motion Axes
from the plant. This leads to proliferation
of Motion Axis objects which are not
connected to an underlying servo object,
which causes additional configuration-
related motion alarms.

The following recipe produces a clean
bus scan without extraneous objects
or variables:

1. Delete all EtherCAT servo
nodes in the plant

2. Delete all servo Motion Axes
in the plant

3. Delete all related global
variables for servo-# and
AXIS# from the PLC global
variables list

4. Perform bus scan

56229

Y RW_Write CSV_File:
Appending doesn't work
when executed with a
task interval lower than
4ms

When using the "Append" input

of Y RW_Write CSV_File in a program run
with a task interval of < 4ms, the
information is not appended to the file.
The CSV file is overwritten as if "Append"
was set to FALSE.

Use the Append mode of
Y RW_Write_ CSV_FileinaPOU ina
task >= 4 ms.

56328

Unable to determine
cause of error when EIP
status variable is set to
0x000E

Detailed status of EtherNet/IP scanner
connection is not available.

EtherNet/IP diagnostics will have to be
done by using wireshark. The user will
have to use a network hub for
capturing network traffic.
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56341

ECAT Online : missmatch
analyzer is showing SLIO
Ecat module in red

The Mismatch Analyzer tab in the
EtherCAT Online Functions page shows
modules in EtherCAT devices in red.

None. This does not affect the
functionality of the modules.

56464

In a project created using
iCE 2023.9, and opened in
2024.3 axes cannot be
used in simulation mode

If a project was created in 2023.9 and
opened in 2024.3, servo axes cannot be
used in simulation mode

Users will have to use real axes for
projects created in 2023.9 and
upgraded to 2024.3

56946

EtherCAT Bus Scan:
Unable to find modules of
EtherCAT devices in
certain conditions

EtherCAT Bus Scan: Unable to find
modules on the CoE bus coupler in certain
conditions. A first bus scan without an
existing configuration on an iC9200
controller can result in modules not being
discovered.

A configuration needs to be present in
the ECAT master for a successful
discovery of modules on a bus
coupler. A write and download of the
project with the bus coupler in the
configuration will establish the
required configuration. A secondary
bus scan will result in the discovery of
modules on the coupler.

Safety modules will communicate over
FSoE only if the bus coupler is set up
in enhanced mode.

56985

Profinet device integrated
via "Online-Devices" has
no name for automatically
integrated variables

Using the "Online-Device" option to scan
Profinet coupelr with SLIO module and
then use the button "Add to project"
create a module with the "Generate link
global variable" checkbox checked but no
variable linked to it :

Uncheck and recheck the box
"Generate and link global variable".
This will populate the -> Field
"Module is linked to variable...".

57944

Motion Axes: ServoNet
positive Velocity limits is
compared to the wrong
value

When using motion axes, if the values to
be used for velocity, acceleration, and
deceleration limits in the positive motion
direction are lower than the position limit
in the negative motion direction, the
software will not allow the setting of said
value (see reference image)

Set the limits for velocity,
acceleration, and deceleration before
setting the position limits

58211

|0 variable generation:
ComState structure
elements display FALSE
and are not linked to PDIs

ComState elements of autogenerated
global variables for SLIO modules is not
currently populated. It displays the value
FALSE always

Do not use the elements of the
ComState structure of autogenerated
|0 variables corresponding to SLIO
modules.
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Importing csv file
resulting in cryptic error
message : Error during
generating native code,
internal meta-compiler

58334

Importing a large csv file can cause a
native code generation error.

Not available.

Cannot rebuild or
download uncompressed
project (possibly because
of a network drive
interaction / antivirus
interaction ?)

58548

Saving a safety project as an
uncompressed project (*.pcwef) renders
the project not buildable and not
downloadable.

2 Suggestions:

e Saving a safety project on a
network drive is not
supported.

e Disable Auto Save in Extra-->
Option/AutoSave

MSync: Buffering a MCS
move when tracking with
active PCS move results in
robot controller alarm

58651

If conveyor tracking is used, and tracking
PCS moves are executed then MCS move
is buffered to abort tracking, it results in
robot controller alarm. If the PCS moves
are still active until TrackState 4, it results
in alarm 4414 (excessive segment alarm)

2 Possible solutions:

e Wait until the PCS moves
finish before executing an
MCS move that would break
conveyor tracking

e Execute MC_GroupStop, then
wait 2 EtherCAT scans, then a
MCS move can be triggered.

Re-ordering EtherCAT
devices by dragging and
dropping in the plant tree
results in a invalid
EtherCAT configuration

58851

IF HotConnect is disabled ("Create HC
devices for slaves" is unchecked) and
DevicelD is not being used, manually
changing the order of devices in the
EtherCAT node of the project's PLANT, will
cause an incorrect position in the
topology. This can affect the EtherCAT
communication to devices.

If the user wishes to reorder devices
in the EtherCAT node of the project's
PLANT, delete all devices and re-add
them. Also make sure that the
'position in topology' for each device
is correct.

Unable to get Sigma-X
CoE data from the
EtherCAT/Online
Functions page

59056

Unable to get Sigma-X CoE data from the
EtherCAT/Online Functions page

Use Y _EC_COE_SdoRead function
block to read EtherCAT objects. EC
Lyzer or EC-Engineer could be used to
get CoE data.

Offset or EtherCAT slave
process datum not
updated

60264

Some module devices have wrong Offset
information display, for example
Sigma7W:

No workaround, this is a display issue
and has no impact on the
communication with the device. Do
not trust the absolute value of the
column "Offset" until iCube Engineer
2026.0.
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60362

"Unknown axis type"
error message when
writing parameters to
Servopack if faulty
network address

The message "Unknown axis type. Write
and start project to the controller before
trying read /write operations again." will
show up if the user tries to Read or Write
from/to a SERVOPACK while there is a
network identification issue:

Open EtherCAT node -> Online
Functions -> select the Master node ->
Mismatch analyzer, and make sure
there is no conflict displayed.

60367

Debug Mode: In certain
situations, the debug
values of variables are not
available in iCube
Engineer's debug view.

In certain situations, the debug values of
variables are not available in iCube
Engineer's debug view. The variables
cannot be added to the watch window.

Declare the variable whose value
needs to be monitored in another
location (POU), and add that to the
watch window.

61204

Unable to delete EtherCAT
device due to Hot
Connect even when
disabled with Beckhoff
EK1100

Unable to delete Beckhoff EK1100

sub device and/or modules attached to
the EK1100 sub device. The Hot Connect
enabled warning is shown even though
HotConnect is disabled.

Not available.

61260

Regression: OPC UA Client
creates monitored item
with wrong
Namespacelndex

The OPC UA client creates tag entries with
the wrong namespace index . This causes
OPC UA communication to fail.

In the variable mapping page, make
sure to use the "*/iCubeControl.com*
namespace as shown below.

,,,,,,,,,,,,,

61487

MSync:
MC_MovelinearRelative
while tracking does not
behave properly if IOP is
non zero and PCS moves
are commanded

Using MC_MovelinearRelative with
coordinate system PCS with
MotomanSync group while tracking a part
with a non-zero IOP leads the robot to
move to an un-expected position.

Define the IOP input of the
MC_TrackConveyorBelt to zero.

61685

Engineering tool
generates motion related
config after motion axis is
deleted

The FMK does not relinquish control of an
EtherCAT Yaskawa servo device even after
the associated motion axis is disconnected
from the servo.

NA. Currently, a Yaskawa servo device
will be under the FMKs control. It is
not possible to control the Yaskawa
servo directly over PDO maps using
user code.

61984

Error: Port with name
'Arp.lo.Ecat/0.Reserved'
already exists Schmersal
SFB device

Schmersal Safety Field Box (SFB) is not
currently supported by iC9226M-FSoE

Not available.
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62023

iCube Engineer Incorrectly
Reports Safety PLC Debug
is Active

iCube Engineer reports Safety PLC Debug
is active in cases where a Safety PLC
project is not running. Examples include
when the safety PLC is in Debug Stop
state and also when a valid project has
not been written to the Safety PLC.

© Safety PLC: Debug Mode Active

From iCube Help (Home -> Safety PLC
Commissioning: From Compiling to
Debugging -> Connecting vs. Monitoring
Mode vs. Debug Mode)

Not

Check the Safety PLC status in the
Safety PLC cockpit while connected to
the Safety PLC to determine if the
Safety PLC is in Debug Run or Debug
Stop state, and also whether or not a
project is present on the Safety PLC.

62024

iCE Pop Out Menus Cover
Other Applications

In iCube Engineer, if a window is popped
out (for example: Watch Window, Logic
Analyzer Window, etc.) the popped
window will cover other Windows
applications even after the user tries to
select the Windows application.

Not available.

62038

PLCopen Part 4.
MC_GroupSetPosition
stuck in Busy when group
is enabled but powered
off and the group moves
or has vibration

MC_GroupSetPosition will get stuck in
Busy state if the user tries to set the
group's position while the axis is
moving/vibrating. This can also happen if
there is no commanded motion but there
is jitter on any one of the axes.

Make sure that there is no motion on
the groups axes while its position is
being defined using
MC_GroupSetPosition. Hint: Execute a
Y_GroupPower before the
MC_GroupSetPosition can help to
resolve this issue.
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1) close iCube if it was opened.
2) Remove the project folder's
synchronization with Onedrive.
If Onedrive is being used to synchronize Sync and backup
files on the PG, it interacts with files used | -
by iCubeEngineer and restricts access to o
Unable to add more than |Cuk?eEng|neer leading to issues adding
. . devices to the EtherCAT node.
one axes to iCube project
(EtherCAT content could
62110 | not be extracted / m— —
EtherCAT folder access Y [ .
denied) - possibly related e cnnt b e 0w
to OneDrive | L . |
3) delete the
folder : C:\Users\...\Documents\iCube
_Engineer\<iCube engineer
version>\ETHERCAT
4) open again iCube and then no more
issue should appear, the insertion of a
new EtherCAT devices should work.
Wh ing iCube Engi t fi
ositon/velocity/acceleration imits on | EX1er (2) Configure the gantry group
Motion Groups: MCS P - y‘ . with additional virtual axes to fill out
. the Limits page view, for a motion group .
limits constructed . all 6 axes, or (b) do not configure the
. as an nD gantry, and not using axes to o .
incorrectly for Gantry . . limits via iCube Engineer. Instead set
62271 . represent all 6 dimensions (XYZRxRyRz), L
groups with non- . .. the ACS and MCS group limits
. the limit values from the ACS (joint) frame . . .
consecutive . . programmatically using function block
. . . may be incorrectly replicated to the MCS . .
dimensionality (e.g. XYRz) . . Y_GroupWriteVectorParameter with
(machine/world) frame in the group
. — parameter numbers 2600-2623.
configuration file.
Forced Output value of
digital output variable in | Forced Output value of digital output Do not rely on the forced value of a
62334 | the project is unable to variable in the project is unable to hold variable in a project for critical logic
hold the forced value the forced value state. decisions.
state.
When creating a new project either from
a template or from scratch, if the IP S
. . L If a new project is created and IP
Write and Start Project address of the controller or the project is .
. . , address of the project or the
(with Sources) does not changed then using Write and Start . .
. . , " " controller is changed, Save the project
62416 | occur on a new project Project (with Sources), a "Save As... . X
. . . . before executing Write and Start
and removes the option window will appears but the write and . , .
. ) ) . Project (with Sources) to download it
to write and start again start will not take place and all options to
. . to the controller.
write and start are greyed out after this
attempt.
Unable to add devices if
”a. etoa eylces "2 1 Unable to add devices after a project .
62417 | project compare is . Close the project and reopen.
compare is performed.
performed.
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62436

Mounting 054-1DA00
SliceBus Module to
EtherCAT SLIO Coupler
Throws 10 Error

Unable to use 054-1DA00 module with a
CoE bus coupler.

Use the 054-1DA00 module on
slicebus.

62470

ESI File import: Unable to
import AKD2G-SPE ESI file
into iCube Engineer

If the ESI file of an EtherCAT

subdevice contains safety modules with
SRA support (for example AKD2G-SPE ESI
file), ICube Engineer will fail to import the
ESI file successfully. SRA support can be
checked by searching for
'SRA_ParameterSupported' field.

Not available.

62603

Incorrect message in
snack bar "Unknown Axis
Type....... " when user tries
to read, write or compare
parameters

Incorrect message in snack bar "Unknown
Axis Type....... " when user tries to read,
write or compare parameters.

Check PLC system variable,
EC_TOPOLOGY_OK. This variable
should be TRUE for successful
parameter management in iCube
Engineer.

62737

PDO: wrong data List if
PDO name is modified

If the PDO name is edited in the PDO list
for a device in iCubeEngineer, the name is
not correctly refactored in the variables in
the PDO data list.

Refrain from renaming the PDO name
in the PDO list for EtherCAT devices in
iCubeEngineer.

62807

iCubeEngineer crashes
when moving cam points
in the cam tool

iCube Engineer crashes when moving cam
points the cam tool.

Do not edit cam points in the editor
tool by dragging and moving points.

63179

Help about is a modal
dialog, that gets hidden
behind a logic analyzer
trace which can not be
moved or dismissed ->
lockup

If you choose Help-About while a pop out
window is displayed, the "About" window
may be hidden.

Resize the screen to a higher
resolution so that the "About" dialog
is displayed and can be dismissed.

63215

Regression: PN282 error
when setting Motor Type
to linear with SGLFW2

If the user configures the motor
connected to a servo as a linear motor, a
compile error is generated prompting the
user to set Pn282 for the servo in iCube
Engineer's parameter. If the user has a
serial converter on the motor (SigmaTrac:
SGLFW), the user should set Pn282 to the
value required for that particular
converter. If the user does not have a
serial converter on the motor
(SigmaTrac2; SGLFW?2), user should not
have to set Pn282. A value of Pn282 set by
the user is ignored if a serial converter is
not used.

Set a value (any value will do) for
Pn282 in the parameter page of iCube
Engineer. The entry will suppress the
compile error. This value is ignored by
the servo when a serial converter is
not used.
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CoE Servo Axis Initial
Value Configuration Not
Updating in certain
situations.

63343

If a non servo motion axis is deleted and a
servo motion axis is added in its place in
the plant, the servo axis will not have
initial configuration set. This will lead to
an error 60910 on PLCopenPartl function
blocks.

Check the initial value of the AXIS_REF
structure to make sure it is correct.
Check the Options page of the motion
axis to make sure that it is mapped to
the desired servo.

Alternatively, delete the AXIS_REF
variable for the VFD after deleting the
VFD from the plant, so that the
variable is not reused as is for the
servopack.

MSync: Interference Zone
is still active after
disabling Y_ActivatelZ
when motion was aborted

63425

Disabling Y_ActivatelZ doesn't remove the
Interference Zone after a movement was
aborted.

Execute MC_GroupReset AFTER
disabling 1Z (Interference Zone)

E1001 Critical internal
error, Error During
Generation of Native
Code

63583

E1001 Critical internal error and Error
During Generation of Native Code
messages are generated when a large
variable is passed through a MOVE block
with EN/ENO connections.

Not available.

Automatic variable
generation: SLIO/SliceBus
counter modules must
not connect global
variable SB_fm.Out fields
when configured in
combination with motion
kernel axis

63588

High speed pulse output (COIN) turns on
at position 0 for the 1BA00 module even
though the user configured comparison
value is non zero.

Uncheck the option to automatically
create and link the global variable on
the module setting page. Delete the

automatically created global variable
from the PLC data list.

Ethernet/IP Scanner:
connection error 0x315
when using config
instance with zero length

63778

When configuring an Ethernet/IP Scanner
connection to a remote peer which
requires a Configuration Instance as part
of the Forward Open request, and the size
of this configuration instance is zero, a
malformed connection request is sent.
The device responds with error 0x315.

Use another connection mode, if
possible, without using a zero-length
configuration instance.

If no other connection mode is
available, it is possible to modify the
configuration file via SSH access to the
controller. Please contact Yaskawa
support and mention ticket #63778.

More than 8 INPACT
MotomanSync EtherCAT
devices can be added to
the PLANT in iCube
Engineer

64039

More than 8 MotomanSync connections
can be added in iCubeEngineer.

Limit the maximum number of
MotomanSync connections to 8.
Please contact tech support or the
online help for recommended settings
for EtherCAT update rate and
application task rates when
MotomanSync groups are configured.
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64609

Unable to open existing
HMI project from iCube
Engineer

User cannot open an existing HMI project
in a new iCube Engineer project unless the
project is within a certain file path with a
certain project name.

Not available.

64741

iCube Engineer 2024.9
SP9 on fresh windows 11
gives error
Microsoft.ACE.OLEDB.12.
0' provider is not
registered

Microsoft Access Database Engine (2010)
is required for proper functioning of iCube
Engineer. iCube Engineer does not install
this database. Without this database, the
user can expect an error mentioning that
"Microsoft.ACE.OLEDB.12.0' provider is
not registered on the machine".

Please install Microsoft Access
Database Engine (2010) on the
machine running iCube Engineer.

64822

Unable to transfer
structures over between
HMI designer project and
iC9226 OPC UA tags if the
tags are synchronized
automatically

If the HMI Designer project is launched
from iCubeEngineer and OPC data is
automatically synchronized from iCube
Engineer, structure data elements will not
work when the tags are applied in the
HMI projects.

Use HMI Designer as a separate tool
and do not launch HMI Designer from
iCube Engineer.

65086

EOE IP address error
occurs when the
controller IP address is
changed, even though
EOE is not active

If the IP address of the controller is
changed, in the controller setting page, in
a project where EtherCAT sub devices are
present, EOE IP address errors can occur.

Double click on the IP address error. In
the EOE page, set EOE to be active, set
port mode/IP port to manual, make
sure all entries in the IP settings are
zeros. Disable EOE (make it inactive).

65124

iCubeEngineer - Crash
after Moving Beckhoff
EL6021 between
EL6002/EL6001 in the EC
Node in the PLANT

iCube Engineer becomes unresponsive if
the a module is moved from one EBUS sub
device to another under the EtherCAT
node in the PLANT.

Do not move EBUS modules between
sub devices in the EtherCAT node. If a
move has to be performed, remove
the sub device and re-add it.

65133

The path of directory not
update in the iCube when
installed by choosing a
different destination for
user data

If the default installation path has been
changed during the installation process,
the user will experienced the following
error when creating a project from
template:

1. Go to Extra --> Option --> Tool
--> Directories

a. Do NOT modify any
path individually

Press "Reset to Defaults"
Press OK
Reboot ICE

vk W

Create a new project from
template

No more issue should appear.
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iCube Engineer Crash:
when iCube Engineer
folders (library,

If a directory path that requires
Administrator rights is selected during
iCube Engineer installation, and the
current user does not have Administrator
rights, then while updating the paths
using Options->Extra, the following dialog
will display and then iCube Engineer will
crash.

During iCube Engineer installation and
directory selection in Options->Extra,

supported object in
SNOLD (CDI0O0008)

'The internal compiler data for the
worksheet 'S_Main:Code' is invalid.'

i= ErrorList [0 Project Log [&) Online Log (¢ Import Export Log  [8) Safety Log

®© Code Description

@ €DI00008 The internal compiler data for the worksheet 'S_Main:Code" is in

65179 ly ch direct th with full
EtherCAT ...) are defined ony ¢ oose? ‘|rec ory path Wi 'u
. . . access permissions for the logged in
in a location that require
. . user.
Administrator rights
Contact and coil types are restricted in
SNOLD (Safety Network Oriented Ladder).
Transition-sensing contacts or coils are not
supported. When using these, the user Do NOT use Transition-sensing
Safety PLC: Unclea'lr rror | will be presented with the following error | .ontacts or coils in
65727 | Message when using a not | message after building the project:

€001 coo1
Tm}@ Iml@
SNOLD
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For MotomanSync groups, queuing
several moves in the motion queue in
advance using a BufferMode different
than Aborting with different tools (using
Y SelectTool in between moves) will
perform correctly, but the
signal Group.ActiveTool will be updated The tool handling is correctly handled
when Y_SelectTool's execution is done for the motion part, but to get the
MotomanSync: . ; . . )
) . and not when the move tool is active. correct ActiveTool information, the
Group.ActiveTool is not . . . .
. —— e |ser has to write their own logic using
66002 | representative of the tool ||=.° S : WA e .
the eroun is using in all - ac | - the "Active" output signal of each
group & 5 " e move function block and update a
cases = e .
customized "ActiveTool" variable
accordingly.
Uncheck and re-check ALL the
Active checkboxes for the
. PDO (Transmit AND Receive) map
PDO Editor: PDI .
, and re-check it.
duplicated generated
66540 | after modifying a PDO Example (just for 1 PDO) :
and reopening an ICE Inputs
project
Active Index Name
v 0x1A00 1st Transmit PDO mapping
After modifying the name of variable
linked to a device in the "settings" page
(either by changing the "function/location
name and refactoring or just changing the
variable name in the PLC table), the
combo box in the setting page is not This is an update/refresh issue of the
] updated automatically. settings page. To solve this issue leave
No refresh F’f dyn?mlc Bosag:  Srwmewr  Bomia  Bammnin _ the Settings page of the device and
66544 combobox In settings | i come back again. Now the display of
editor the linked variable should be
corrected.
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Delete the following

file: "C:\Users\ fuser

name }\AppData\Roaming\PHOENT
X CONTACT\Application
Control\CertificateStore.bin

". This file will be created at
application startup if it does not exist.
It contains certificates which are used
for the gRPC layer of the ACI.

OR

You can change the port setting
with administrator rights on the

iCube Engineer won't Application Control Interface

67512 open due to "Key not iCube Engineer crashes with the "Key not tion ]
valid for use in specified valid for use in specified state" message. Op lon page.
state” error and crashes

Modify application options
Select category and edit opfions

€ Communication Settings A~ Application Control Interface

Wi Start S
Vrite and Start Settings [] Enabled

. Communication port number:
v Compiler

1 Write and Start Commands
IEC Compiler Settings
Wamings Settings
v EN/JENO
EN/ENO Settings
l v Cross references
Setiings
v HMI Editor
Page Settings
Symbol Settings
v GSDML Import
GSDML Import Settings
{ GSDX Import Settings
v OPC UA
OPC UA Client Settings
v Administration
‘ Trust stores
| Password Manager
Application Control Interface

To determine the byte number of the
offset for EtherCAT devices, divide the
In the "DatalList" tab for EtherCAT devices | Offset” value by 8. The remainder of

Data List: The Offset the "Offset" column shows the bit number | the division by 8 is the bit offset

Column on EtherCAT s
i " " ac ic | within the byte.
67638 | device is shown as "Bit" of the offset instead of the "Byte.bit" as is

address instead of shown for Slicebus and Profinet devices The offset value for the safety
"Byte X" address but shows correctly the format for safety | yariables shown in the datalist

. variable in the same table. represent the memory offset of the
safety PLC and is then different that
the one of the standard Controller.
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Servopack stuck in A.A12 -
Arp.lo.EtherCAT.Internal.S
tackLogging - ERROR -
Notify

In some scenarios, the EtherCAT devices
can show an EtherCAT communication

The error can be resolved with
changing EtherCAT cycle time,

67974 EC_NOTIFY_FRAME_RESP | issue, but EC_Topology = TRUE and each rebuilding project and changing cycle
ONSE_ERROR(No EtherCAT slave are in Op state. time back to original value.
response error for cyclic
frame
When adding an Ethernet/IP Generic
Adapter device to the plant, if the
Application Type is selected as "Input-
Only" or "Listen-Only", then the handling
of the 02T (originator to target) Enter a dummy value such as
connection fields is incorrect. 1 for the O2T size and
. Instance ID. This value will be
Ethernet/IP generic e The 02T size field is incorrectly : q
adapter device : required to be non-zero (it is in snorec
EthernetiPScanner ‘ qt | o Non-standard 02T heartbea‘lt
68587 | configuration: incorrect o |fa V\fys :ero)or ; instance IDs are supported in
handling of Input- _?_Ep lg;_lclm type D field i . the co‘ntroller config file, but
Only/Listen-Only 02T ° € ; nsdanC(te) 'Idleh IS ho there is no method to set
fields actu§ yuse to build the these fields via iCube
configuration. The commonly- Engineer. Contact Yaskawa
used standard values of 198/199 support for details on how to
are always used instead. The manually edit this file.
setting of this field is ignored,
even though it enforces a non-
zero requirement as a build
precondition.
Exception occurred: 'Insert
variable:'Arp.lo.Ecat/... already exists" at
component Arp.lo.Fblo.Ecat on SetupPlc
error can happen if there are two PDI
Exception occurred:'Insert | variables with the same address. This
variable:'Arp.lo.Ecat/... could have happened because of a device | Remove the EtherCAT device that is
68861 already exists" at being renamed. The symptom is shown causing this. Re-add the device and

component
Arp.lo.Fblo.Ecat on
SetupPlc

below.

This should not be in the ethercat data list ‘

check the data list to make sure that
there are no duplicate entries.
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69853

OPCUA: Controller Service
Activation breaks OPC UA
via Namespace Index

Changes

If OPC UA services activation are modified
(e.g. enable OPC UA client, PubSub,
Profinet services...) on the controller using
WBM, then OPC UA communication that
was configured using auto synchronization
of tags between HMI Designer[OPC UA
client] and iCube Controller[OPC UA
server] will get affected.

Solution 1: Don't use the Auto
synchronization of the variable, but
use the manual import of OPC UA tag
from the controller, by following the
Application note : How to establish
OPC UA communication between HMI
Designer(Client) and iC9200
Controller(Server)

Solution 2: Keep the services of the
controller with the default value.

69953

Motion Axis: Negative
position scale does not
also set negative torque
scale - axis alarm results

Defining a negative position scale in the
configuration tab of a motion axis, will
end up with the following motion alarm :

Motien Alarms

e Do not define a negative
position scale for a motion
axis.

o Ifthereisaneedto
invert the forward
direction of a motor,
change it with its
related parameter in
the drive. Example
with a SERVOPACK,
modify parameter

Pn000.0.
3.3 iC9226 Firmware Known Issues
ID Title Description Workaround
E:)ii:g??;e:xit When DHCP is enabled, the PROFINET functionality is not
16544 supported and is automatically disabled in the Not available.
the PLCnext . .
.. configuration.
application
Spike in
commanded
velocity and
Torque at the Use a low value for velocity for
18996 end of There can be a jerk in motor position when the c pulse is detecting the c pulse when the
MC_StepRefPuls | detected using the MC_StepRefPulse using a high velocity. | MC_StepRefPulse function
e block is used.
implementation
- missing decel
input
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31468

Data memory
limits on the
iC922x

The maximum data memory is 32MB for optimal operation
of the iCube Engineer project on the iC9200 controller.

If the data memory size of the project is between
32 MB and 64 MB, the user may encounter failure
executing 'Write and Start Project Changes' to the
controller. There will be no compile error.

If the data memory size of the project is between
64 MB and 128 MB, the user may encounter
failure executing 'Write and Start Project' to the
controller. There will be no compile error.

If the data memory size of the project is greater
than 128 MB, the user will get a compile error and
will not be able to 'write and start' the project.

Keep data memory usage to
less than 32MB.

33996

FSoE CPU is not
working without
FSoE module

Safety PLC will not run without a configured FSoE module.
The SF ER will be lit all the time.

Add a FSoE slave in the project
configuration and map at least (1)
safety process data item to a
safety PLC variable. If the safety
module is not actually present, a
topology error will be reported,
which can be ignored. The
communication to the existing
modules is running.

34460

Parameters 1305
and 1307 for
scan
compensation
incorrect values
or not settable
for Ethercat
external
encoders

Parameter 1305 (feedback compensation) is fixed to a
value of one network cycle. It cannot be modified.

Not available.

34872

SliceBus network
shutdown when
a breakpoint is
reached

If a breakpoint is activated for the first time (logic halts at
the breakpoint), the PLC enters debugging state. In this
state the various fieldbuses (EtherCAT, Slicebus) stop
running and all outputs are set to state FALSE. The PLC
leaves the debugging state only when all breakpoints in
the project are removed.

It is not possible to keep the
fieldbusses running when the
PLC enters the debugging
state. The PLC State can be
monitored using the
notifications tray in iCube
Engineer. Do not use
breakpoints if the application
requires fieldbus activity while
in the debugging state.
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34961

Unexpected
behavior of
'Debugging' flag
when a
breakpoint exists
in a project and
the PLCis
stopped and
started

If a breakpoint is set in a project , and the project is
stopped and warm started, the PLC should start with
'debugging' mode enabled. However, there is a short time
period (2 ms) on startup where the PLC runs without the
'debugging' flag before the 'debugging' flag comes on.
During this time period, all physical output states would
change based on programmed logic before becoming
FALSE because of the debugging flag.

Not available.

39022

Logic Analyzer
inconsistent in
picking the
trigger for short
duration pulses
on local and
remote modules

Logic analyzer cannot trigger a plot based on a rising or
falling signal if the trigger variable (not a port variable) is
tied to a process data item (like a digital input or output)
and the signal has a small pulse width (1 or 2 ms).

Map the process data item to
a port variable and use the
port variable to trigger the
logic analyzer.

40832

Non safe
exchange
variable has
unstable state
when the safe

When the FSoE device communication state is not in
"ProcessData" (regular operation), then the non-safe PLC
exchange variable value is not valid.

Verify that that FSoE device is
in "ProcessData" state before
using the exchange variable
value. Contact Yaskawa
support for more information
on how to

40870

module is use FSOE_MSTR_ADDR_0000x

passivated _PASS_OUT to check for the
status of the device.

No error

generated when
bypassing the
32Mebibytes
data Memory
limit

User is able to add variables that consume data memory
greater than 64 MB.

Make sure that the total
memory used in a project is
less than 32 MB.

41020

Limits for Safety
PLC number of
variables and
process data
mapping are not
checked at
compile time

There is no error message in iCube Engineer if the limits
for Safety PLC variable assignments mapped to process
data is exceeded until an attempt is made to download the
project to the safety PLC.

Use the following limits for
variables which are mapped to
safety process data in the
Safety PLC:

- The total of all variables
which are mapped to the
safety process data must not
exceed 19980 bytes.

- Each safety variable which is
mapped to process data
occupies 16 bytes.

- Each standard variable which
is mapped to process data
occupies 8 bytes.
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44020

SPLC1000 board
with under/over
temperature
shutdown can
not be
diagnosed
usefully

If an overtemperature/under temperature error occurs on
the safety PLC, it goes into a Hard Fail-safe state: the safety
CPU will set the red ERR LED and and stop all
communication; all connected FSoE devices will enter fail-
safe state after FSOE communication watchdog time. Once
the heartbeat between the standard PLC and the safety
PLC detects that communication between the safety PLC
and standard PLC has stopped, the data from the safety
PLC will no longer be valid.

Include heartbeat logic in the
code on the standard PLC to
detect that the safety PLC is
unresponsive and to
determine if the data from the
safety PLC is valid.

44534

ErroriD 4915
when using
Y_WriteParamet
ers on SGDXS

Y_ WriteParameters for CoE servopacks may intermittently
return error 4915 (parameter write failed) rather than
4916 (servopack reboot required).

Verify the parameters are set
correctly with

Y VerifyParameters to confirm
the write succeeded.

47907

iC9226M-FSoE:
PLC state
changes to STOP
with Watchdog
under heavy
network load
with UDP
broadcast frames

Under high network load with UDP broadcast frames, it
could happen that the standard PLC state changed to
STOP because the watchdog time of the SafetyProxyTask
was exceeded.

None, except avoiding heavy
UDP broadcast load

49270

In a continuous

power cycle test
in rare cases the
IO DIAG LED is lit

It can happen sporadically that the 10 DIAG LED is lit at
start up without the log mentioning the issue. This means
no issue is present.

If the 10 DIAG is lit without log
information, perform a power
cycle or write and start a
project.

51216

LLDP duplication
between
PROFINET
Device/Controlle
r and Ethernet/IP
Adapter

Ethernet/IP and Profinet Device have different
specifications and implementations for LLDP frame
emission. Thus, multiple frames are emitted, with different
content, if both components are enabled. This can cause
some automatic device configuration issues with the
Profinet network.

It is recommended to disable
the Ethernet/IP component
when using the Profinet
Device/Controller component,
and vice versa. This can be
configured using the WBM
System Services view.

If both Ethernet/IP and
Profinet are required in the
application, please contact
Yaskawa support for assistance
to defeat the Ethernet/IP LLDP
feature.

54091

EtherCAT DC
sync is not
checked for
initially
unpowered hot-
connect axis

At project start, the motion kernerl verifies that all Sigma
servopacks are configured with DC sync enabled. If DC sync
is disabled, a warning alarm is posted for the axis.

If a hot-connect configured axis is initially offline at project
start, the DC sync status of the servopack cannot be
verified.

Keep DC synchronization
enabled for all Sigma
servopacks.
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54297

Diagnostics
EtherCAT Page in
the Web
Management
shows detected
slaves when no
slaves are
configured in
project, but
there are slaves
on the EtherCAT

The EtherCAT diagnostics page in the WBM can show the
detected slaves on the EtherCAT network, when no slaves
are defined in the project configuration.

Do not use the EtherCAT
diagnostics page to verify the
number of sub devices (slaves)
configured in a project. Use
the project configuration in
the PLANT tree of iCube
Engineer.

network

Unable to

download to

iC9226 if R . . . Do no activate the Profinet

. Activating the Profinet Controller services without the . s

Profinet . - . . Controller functionality if the
56171 . Profinet license will unload the project in the controller . .

Controller is . . controller doesn't have prior a

and forbid any new project download. . .
enabled and Profinet license.

Profinet license
doesn't exist.

56683

Ethernet/IP: 10
connection
RPI/API not
checked against
actual maximum
update rate

The Ethernet/IP Scanner and Adapter components share a
single cyclic update rate, which is configured in iCube
Engineer on the Assemblies tab, Schedule Interval field.

Neither outgoing scanner 10 connections nor incoming
adapter 10 connections correctly advertise the RPI / APl on
the wire, if lower than this configured limit.

This can lead to unexpected timeouts or connection errors.

Set the Schedule Interval to
the minimum expected
production interval for all
scanner and adapter
connections expected in the
system.

58060

Sigma-X
A.EO0/A.EAQ
after power cycle
with the iC9226
in run state

If there is only one servo is on the EtherCAT network and it
is rebooted, the iC9200 may not stay in OP state. It goes to
safe OP state along with the servo.

Warm start the iC9200.

62379

Troubleshooting
EtherCAT:
"ERROR: Line
Crossed" -
Unable to
Download
project after
Reset type 1

When trying to download an empty project to the
controller, where the hardware wiring is wrong, below
shown error is thrown.

Plc failed: 'Exception occurred: 'Invalid parameter value: ‘ecatConfigureMaster error code’ = 'ERROR: Line crossed™ - at compx|

(MSG_ONLO196)

Check the EtherCAT cable
wiring. Every cable needs to
start from an output port and
be connected to the IN port of
the next device.

62411

Unable to
download
changes if an
outputisin
forced state

User is unable to download changes if a hardware output
is in forced state.

Not available.
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63146

Local-SLIO
synchronous
mode consumes
75% of CPUO

In Slicebus settings, Synchronization Mode should be
enabled for counter modules that support Slicebus
External Axes. When synchronous mode is enabled for
SliceBus with any local-SLIO module (such as a pulse
counter), CPUO load (core 1 load) is consistently 75%. If the
cpu load is increased, then Profinet and Ethernet/IP
performance will be reduced.

Enable synchronization mode
on slicebus only if a module
with counter functionality
(example: 050-1BA10) is being
configured. If counter
functionality is not being used
on slicebus, leave the
Synchronization mode at
default. As an alternate
solution, the counter module
can be configured on an
EtherCAT bus coupler.

63182

FSOE controller
fails to load
config with 28+
aux axesina

group

If a gantry group is created with many (27+) auxiliary axes
(with or without configured XY Z Rx Ry Rz axes),
downloading this project to the controller will cause a
software crash. A type-1 reset is required to recover.

There is not a well-defined use
case for an axes group with 27
or more auxiliary axes. Do not
configure such groups in the
engineering tool.

63722

Ethernet/IP:
iCube adapter
cannot detect
02T 'retain state
when PLC stops'
= FALSE behavior
from an iCube

The Ethernet/IP adapter component requires all Exclusive
Owner 02T I/0 connections to use the Run/Idle flag.

When the remote scanner connection is IDLE, then the
data values are discarded as required by specification.

Thus if the data value are also transitioned to 0 on the wire
while IDLE, this is not reflected in the data within the
userprogram.

Note there is not a method to detect the Run/Idle state of
a connected Exclusive Owner O2T connection.

Maintain a heart beat variable
to monitor communication
with the scanner. When the
connection drops, make sure
that the input data is not used
in the application on the
adapter.

63832

scanner
This behavior is most easily observed in combination with
another iCube controller as a scanner with "retain state
when PLC stops" set to FALSE/unchecked.
. For iCube firmware versions after 2025.6:
PxC runtime -
2025.0 -
backward Rebuild the project with newer

incompatibility
with
PLCnextBase
library 1.5.1in
user projects

If the user project contains PLCnextBase 1.5.1 library or
earlier, or another library which references it - such as

Y Yaskawa_Toolbox - AND certain function blocks are
instantiated in the user project programs - such as

Y YA _SetRTC, then the project will fail to load at startup.
This may not manifest until the following controller reboot.

libraries which reference
PLCnextBase library 1.7 or
later.
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63990

Axis
permanently
remains stuck in
the stopping
state if MC_Stop
is executed while
MC_GearlInPos is
still waiting to be
engaged.

If MC_Stop is executed while MC_GeralnPos is busy,
MC_Stop stays stuck busy. The axis stays stuck in Stopping
state.

Do not execute MC_Stop while
MC_GearlInPos is busy.

63995

SliceBus counter
module does not
initialize position
to 0 on warm
start

2024.9 firmware does not initialize the SliceBus counter
module incremental encoder axis position to 0 on warm
start.

Note: this applies to incremental mode encoders (only)
which are managed by the motion kernel.

Call MC_SetPosition with an
appropriate position value
(such as 0) from a user
program at an appropriate
time during system
initialization.

64407

Executing
MC_GroupStop
while Group
Synchronized
motion state is
active causes
MC_GroupStop
to error out

If MC_TrackConveyorBelt function block is used to
synchronize a group with a conveyor and the group is 'in
sync' with the conveyor, without any active or buffered
MCS or PCS moves, and an MC_Stop is executed, MC_Stop
generates and error and does not show done. Motion is
aborted but the state is not changed correctly

Turn MC_Stop.Execute to
FALSE and continue with the
application.

66038

Hot Connect
SubDevice ends
up in SAFEOP
after being
reconnected to
the network

If there is only one servo is on the EtherCAT network and it
is rebooted, the iC9200 may not stay in OP state. It goes to
safe OP state along with the servo.

Warm start the iC9200. User
can use the
Y_YA_RebootController
function block to reboot the
controller using application
code.

3.4 iC9226 Motion Application Notes

executed while
the master and
slave are in
motion

the new Y_Camin. This happens when repeated cam
synchronization- desynchronization cycles are performed.

ID Title Description Workaround

Drift in position Use slave absolute mode

of slave for one . . when repeated cam

. If a one way, slave relative mode Y_Camin is executed o
way, relative . . . synchronization-
repeatedly while the master is in motion, the slave -

cams that are . . desynchronization cycles

20033 experiences a loss of position of one scan at the start of

have to be performed.
Contact Yaskawa for further
details and discussions based
on application requirements.
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Verify the starting conditions
when the block will be
MC_GearlnPos: .
. executed to check if there can
PositionTracker . . .
In some situations, MC_GearlnPos can cause temporary be backward motion on the
can cause slave . . - . . .
40843 motion in reverse motion during synchronization phase. This may be | slave axis during the
. unexpected for some applications. synchronization attempt. Use
opposite . L
S with caution if backward
direction . .
motion on the slave axis can
cause damage.
Large cam out
disengage The window should be
window causes . . calculated such that it is
. A larger Y_CamOut disengage window can lead to an o
46472 | aninstantaneous | . . . Iy . larger than the position
. . ", instantaneous jump in position on camming out. .
jump in position travelled by the master in one
when the slave is motion network scan.
disengaged
MC_MoveCircula
rAbsolute Determine the start-point of
generates MC_MoveCircular with MC_CircleMode#Border uses very . P .
. . . the circle programmatically,
unexpected tight tolerances to determine whether AuxPoint2 should .
) . . L . . and assign it exactly to the
trajectories - be considered. When working in 3-dimensional XYZ space, o
. . ; end-point in the user
50028 | start/end this can lead to unintended circular move geometry, .
fe . . . . program. Manually entering a
position including being in the wrong plane (i.e. XZ vs XY) when the | .
. . . . . fixed LREAL value for the end-
matching circle start-point and end-point are intended to be o
point is not recommended for
tolerance for colocated, but do not match exactly. .
s o this use-case.
AuxPoint2 is too
tight
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50808

Problems with
PCS handling for
group's
rotational axis
defined as a
linear load type

If a group’s rotational axis is defined as “Linear (finite)” in
its configuration, the group will not handle said axis
correctly when commanding trajectories using a PCS
coordinate system. In such a case, multiturn rotations are
not handled. For example, a rotation of 720° was
commanded in the following image.

LOGIC ANALYZER v x
3 “fo| B D LG o Xk =, 000

Machine.CmdPos[6]

Part.CmdPos|[6]

1
‘i Machine.ActualPos[6]
2

Part.ActualPos[6]

182850006 18:28:55.006 182000006 182905006 18:29:10.006

Also, PCS movements where the rotational axis’ position
crosses 0 might cause a jump in the MCS position, as seen
in the following image. The servo will throw an alarm in
such a case, stopping the motion of the whole group.

als

El v BB MExE =2 00D

Machine.CmdPos[6]

x x x x %

Part.CmdPos[6]

Machine.ActualPos[6]

Part.ActualPos[6]

183100006 183102006  1G3T04006 183106006  183L0B006  1B3LI000 18312006  18ILI4006 183116006

LOGIC ANALYZER |

Some possible workarounds
are:

e Do notuseaPCS
coordinate system

e Select target
positions that avoid
conflicting
trajectories

e Add middle positions
commanded in MCS
to avoid conflicting
trajectories
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58494

Unexpected
back-and-forth
movement when
blending with
MC_Movelinear
Absolute, when
MC_BufferMode
#Aborting is
used in actually
buffered
scenarios

PLCopen Part 4 multi-axis motion
(MC_MovelinearRelative, MC_MovelinearAbsolute)
blending between two consecutive moves can follow an
unexpected trajectory for the first part of the move,
including a sudden change in velocity.

This occurs only when the first move in a multi-move
sequence is specified with MC_BufferMode#Aborting
input (which is the default), followed by
MC_BufferMode#BlendingXXXX.

The motion produces a back-and-forth movement
between the 2 first segments during the blending

transition as follows:
back-and-forth
/ movement

Point 2

Point 1

........ segments

Point 3

Notes:

e |nthis scenario, MC_BufferMode#Aborting is

equivalent to MC_BufferMode#Buffered, because

there is no in-progress move to abort.

e |ngeneral, if a MC_MovelinearXXX with
MC_BufferMode#Aborting does cause an in-
progress move to abort, a following move with
MC_BufferMode#BlendingXXX is not supported

(an error will result). A full stop is required before

the next move is possible.

result blended trajectory

Use
MC_BufferMode#Aborting
only when actually needed,
to abort an in-progress
motion. Prefer to use
MC_BufferMode#Buffered
otherwise.
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PLCopenPart4
group moves:
Aborting moves
with
TransitionMode#
TMNone does
not produce stop
/ sharp-corner,
unexpected
trajectories
result

58528

PLCopen Part 4 multi-axis moves with
MC_BufferMode#Aborting can be unintuitive in the
resulting trajectory geometry, and do not follow PLCopen
Part4 specification in some situations.

The PLCopen specification calls out behavior for
MC_TransitionMode#TMNone for Aborting buffer
mode. A full stop is indicated.

O

The transition mode argument is currently
ignored in iCube implementation

The implementation always attempts instead
to produce a smooth change-of-direction
with non-zero velocity.

= This is similar to the PLCopen
specification for
MC_TransitionMode#TMDefinedVelo
city

A multi-axis aborting move cannot be then blended
into another following move: a full stop or another
aborting move is required.

O

Note: Any blended
MC_BufferMode#BlendingXXX input on a
following function block is silently converted
to MC_BufferMode#Buffered which will
cause a full stop in between.

The geometry of a multi-axis aborting move is
unspecified. It may, depending on the initial-
conditions, endpoint, and vel/accel/decel
constraints:

O

O

overshoot the final target and return
execute a spiral type move to the target

combine a curved path with a straight-line
path, possibly including a full stop at an
arbitrary intermediate point

decelerate to a full stop to an arbitrary point
in the original line of action - possibly
including the original endpoint - then
continue to the next point (equivalent to
#TMNone)

The exact trajectory behavior is dependent on the
initial conditions: thus the exact timing of the start
of the move can cause changed behavior.

O

Consider variable timing of execute rising
edge in the user program

In most cases, reducing the
velocity constraints or
especially increasing the
accel/decel constraints can
produce a more intuitive
trajectory which more closely
follows an idealized sharp-
corner transition.

Consider the inputs to the
function block as well as any
velocity/acceleration limits
configured on the axes group
(ACS, MCS) and individual
axes, all of which are in
effect.

Consider also using MC_Stop
+ MC_MovelinearAbsolute
when a full stop and sharp
angle transition geometry is
required.

For future compatibility,
scenarios which want to
preserve the current behavior
should input
MC_TransitionMode#TMCons
tantVelocity. It's possible that
in the future, TMNone will be
honored according to the
specification.
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Consider variable delay between execute
rising edge and initiation of the move in the
motion scan, which may be delayed by high
CPU load

The resulting trajectory is not pre-computed a
priori, but instead computed iteratively each cycle
given the current state, the end state, and the
constraints. Thus the only way to predict the exact
behavior is to simulate it with exactly correct input
conditions.

o There are a very large amount of input

conditions which play into this trajectory
algorithm. While the results are
deterministic, analysis of upper and lower
bounds of the envelope of the motion is
highly complex.

"High" acceleration/deceleration values
(relative to velocity and distance values) give
the most intuitive behavior of the trajectory,
with the least deviation from an idealized
sharp-corner turn.

Y_WriteDrivePar
ameter truncates
input values
which are out of
range for the
datatype

61095

Y_WriteDriveParamer does not check that the input DINT
value is within the range for a 16-bit signed or unsigned
value, if the actual datatype of the parameter is a 16-bit
size. The data is instead masked to include only the lower
16 bits. This can cause unexpected parameter write values
without function block errors, if the input data is outside
the datatype range for 16-bit parameters.

Check that the input value is
inside the range [-32768,
32767] or [0, 65535] for
signed or unsigned 16-bit
parameters. Verify written
parameters with
Y_ReadDriveParameter.
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